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1. About this document 

This user guide has been produced for users of the FreqCalc online calculation 

program developed by Getzner Werkstoffe GmbH. Users are assumed to be 

familiar with the use of the internet and to have a basic technical knowledge of 

the field. 

1.1 Layout
 

Sidebar

The sidebar contains general safety notes on avoiding errors, particularly oper-

ating errors, together with background information on the physical principles 

and important information about vibration isolation. 

Symbols

 

This user guide explains how to use FreqCalc in the appropriate way. The follow-

ing symbols are used: 

This safety note warns of the risk of serious errors in operating the program.  

Operating errors can lead to serious design faults and hence to damage to 

installed machines or components. At these points always check that you have 

entered your data correctly. If you need help with technical questions, consult 

a trustworthy source with technical expertise or contact Getzner Werkstoffe 

GmbH. 

This safety note warns of the risk of errors in operating the program that could 

lead to a misinterpretation of the results or to a loss of data and indicates safe-

ty-related aspects of data management. At these points double-check the data 

you have entered.  

This note offers tips to simplify the use of the program or provides background 

information on calculating or interpreting results. 

WARNING

CAUTION

NOTE
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Styles

Any data that can be entered via your computer keyboard  

is printed in italics in this guide.  

This data may be either text (e.g. project XY) or numbers  

e.g. 12,345). 

All inputs that can be made with your mouse are printed in bold in this guide. 

Sequences of steps are linked by means of a > symbol. 

Example: Select File>Print 

This symbol indicates a required action. It instructs you to carry out an action. 

This symbol indicates the results of an action. In order to obtain the results, you 

must first carry out the preceding action. 

Screenshots 

Screenshots illustrate individual steps or results and are designed to help you 

carry out the actions. The relevant areas are framed by a red line.

 

1.2 What does FreqCalc do? 
 Appropriate usage
 

FreqCalc is used for calculating elastic polyurethane materials from Getzner 

Werkstoffe GmbH. 

The calculations are based on the physical model of an SDOF oscillator with 

a weightless spring on a solid, smooth foundation. The calculation program 

FreqCalc makes calculations based on the assumption of loading with a rigid 

mass in the centre of gravity.  The calculated values are relevant for the degree 

of freedom in the vertical direction (1st degree of freedom), taking into con-

sideration the non-linear behaviour of the material. The latest material data is 

always applied, taking shape factor dependence into account. Calculations that 

do not fall within this model cannot be performed with FreqCalc. 

Italic

Bold

>

 

-
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2. Requirements and safety 

FreqCalc is a web-based solution and operates in a web browser. All values for 

the calculation are entered in an input screen. The calculation is performed on 

the server. Then the results are returned to the program. FreqCalc operates 

independently of any operating system. No installation on your computer is 

required. You do not need administrator rights. All you need is internet access 

and a standard web browser. 

2.1 General safety notes

In order to use FreqCalc, you need a basic technical understanding of the field. 

Only use the program if you are able to interpret the results correctly.

2.2 Web browser recommendations

You can use any web browser, provided it supports the following functions: 

• Cookies

• JavaScript 

Optimum results for error-free operation are obtained with the following web 

browsers:

• Microsoft® Internet Explorer® Version 7 or higher - http://www.microsoft.com 

• Mozilla Firefox® Version 3 or higher - http://www.mozilla-europe.org

Use the recommended web 

browsers to ensure error-free 

operation.

NOTE
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2.2.1 Configuring trusted sites 

FreqCalc operates with JavaScript. The default security level in Microsoft® 

Internet Explorer® can prevent pages containing ActiveX or Script elements and 

plug-ins from displaying correctly. If you use Microsoft® Internet Explorer®, add 

http://www.getzner.com to your list of trusted sites. 

 › Start Microsoft® Internet Explorer®.

 › Select Tools >Internet options.

 – The Internet options dialog opens.

 › Select the Security.

 › Select the Trusted sites zone and then click Sites.

 – The Trusted sites dialog opens.

 › Enter http://www.getzner.com in the input field and click Add.

 – The site now appears under Websites. 
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2.2.2 Configuring the pop-up blocker

FreqCalc allows you to export calculations in PDF format. The export function 

uses pop-ups. If you use Microsoft® Internet Explorer® it is advisable to config-

ure the pop-up blocker to allow pop-ups from  

http://www.getzner.com. To configure the pop-up blocker, proceed as follows. 

 › Start Microsoft® Internet Explorer®.

 › Select Tools>Internet options.

 – The Internet options dialog opens.

 › Select the Privacy 

 › Tick the Turn on Pop-up Blocker checkbox and then click Settings.

 › Enter http://www.getzner.com in the input field and click Add.

 – The site now appears under Allowed sites.

 – Pop-ups from this website are allowed.

apps.getzner.com8
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2.3 PDF reader

You can export calculations in PDF format and save them on your computer or 

print them. This allows you to display the input values and calculated results in 

an organised fashion. In order to read or print the PDF files you need a standard 

PDF reader. These are available on the internet for download from the manufac-

turers‘ websites and are normally free of charge.

Standard PDF readers:

• Adobe® Reader®: http://www.adobe.com 

• Foxit® Reader: http://www.foxitsoftware.com

• PDF-XChange Viewer: http://www.tracker-software.com 

 

2.4 User account 

FreqCalc can only be used if you have an active user account on the Getzner 

Werkstoffe homepage. This user account gives you access to the closed website 

area, with specific information about materials and products. This information 

includes:

• General material data

• Background information about material properties and vibration isolation

• Chemical resistance of materials

• Material data sheets for the Sylomer® and Sylodyn® product ranges

• Product data sheets from the railway and construction sectors

• FreqCalc calculation program
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2.4.1 Creating a user account

To create a user account on the Getzner Werkstoffe homepage, proceed as 

follows. 

 › In the address line of your web browser type the address    

 http://www.getzner.com.

 › In the menu at the bottom left of the screen select Login.

 › In the text underneath the input fields select the word >Register now.
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 – This will take you to the registration page.

 › Enter your personal details in the required fields and read the note in the  

 right-hand column.

 › Tick the checkbox to confirm that you have read the note in the right-hand  

 column.

 › To complete the registration process click Submit.

By sending us your data you 

agree to your data being 

stored on our server and pos-

sibly to being contacted by a 

member of the Getzner Werk-

stoffe team. We will not pass 

on your data to third parties.

Your password is sent to the 

server in encrypted form. 

For that reason the string of 

characters displayed in the 

input field is longer than your 

password.

Store your password separate-

ly from your email address. 

Choose a location which no-

body else can access. Getzner 

Werkstoffe will never ask you 

for your user details over the 

telephone or by email. If you 

receive a suspicious email, do 

not reply to it. Instead please 

notify us immediately by call-

ing us on  +43-5552-201-0. 

CAUTION

NOTE

NOTE

Registration form
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 – You will shortly receive an email sent to your nominated email address.

 › Click on the confirmation link in the email to confirm your registration.

 – This will take you to the Getzner Werkstoffe homepage.

 –  Three selection fields appear in the web browser: FreqCalc, Typematch and 

TimberCalc

 ›  Before you can use the FreqCalc or TimberCalc programs, you will need to 

request authorisation by clicking Request authorisation

 –  Once your request has been verified, you will receive an email confirming 

successful activation and containing a link to the relevant calculation program 

(FreqCalc or TimberCalc).

 ›  You only need to activate the program once. You can now access the desired 

calculation program via the login field on the Getzner Website.

 ›  You can use the Typematch program without requesting authorisation by 

clicking on >Open Typematch.

It can take up to 24 hours 

to process an application. 

Getzner Werkstoffe reserves 

the right to deny access to the 

calculation program. 

 

NOTE
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2.4.2 Changing your user settings and password

You can change your details in the closed user area at any time. 

 › In the address line of your web browser type the address    

 http://www.getzner.com.

 › In the menu at the top right of the screen select >Login.

 › In the Login screen enter your email address and your password.

 › Click >Login.

 – This takes you to the closed user area.

 – The user symbol is displayed with your name at the top right.

 › Move the cursor over the user symbol and click >Change userdata.

 ›  Enter any changes in the corresponding input field and confirm by clicking  

> Submit.

 – The text will confirm that your details have been updated.
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2.4.3 Logging out
 

You can leave the closed user area at any time.  

 › Move the cursor over the user symbol and select >Logout.

 – You will be logged out and returned to the login screen.
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You can reset your password at any time. 

 › In the address line of your web browser type the address 

 › http://www.getzner.com.

 › In the menu at the top right of the screen select Login.

 › Select >Forgot your password? under the password input field.

 – Type your email address in the input field and click    

 >Reset password.

 – You will shortly receive a new password sent to your nominated   

 email address. 

Remember to change your 

password again once it has 

been reset.

NOTE
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3. How it works

FreqCalc is an online solution. This means that you do not have to install the 

program on your computer in order to use it. So no program data or material 

values are stored on your computer, and the program does not access your 

computer to perform a calculation. 

All the input values needed for a calculation are entered in an input screen (the 

user interface). There are a number of different functions and input options. 

Once you have finished entering your data, clicking the Calculation button in 

the user interface sends all values to the Getzner Werkstoffe server. The cal-

culation is then performed on the server. The results are returned to the user 

interface and displayed as numerical values and graphs. 

All connections are encrypted and ensure the highest security standards.

USER

Getzner Werkstoffe

SERVER

Calculation of 

Material data
User interface

Input values

Results +

Graphs

Encrypted connection
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The first time you start the calculation program you will see the conditions for 

using FreqCalc. Read them through carefully and accept them. You can also 

download and store the conditions for use in PDF format. To start the program, 

proceed as follows.

 › Log in to the closed user area on the Getzner Werkstoffe website.

 ›  Select Open FreqCalc on the overview screen for the different calculation 

programs.

 – The conditions for use will appear.

 › Read through the conditions for use carefully.

 › Tick the I accept the conditions 

 checkbox and then click >Continue to FreqCalc.

 – The FreqCalc calculation program starts.

4. Starting FreqCalc

You can also download and 

store the conditions for use in 

PDF format. To do so, under 

the conditions for use select 

>Download as PDF.  

If you do not want the condi-

tions for use to be displayed 

each time you open the 

program, tick   

>Don‘t ask me again.

NOTE
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4.1 Customising your profile

You can personalise your settings and user data at any time.  

To do so, proceed as follows. 

 › Move the cursor over the user symbol and select >Change userdata.

 – The settings dialogue opens.

 › Enter the corresponding details into the required fields.

 ›  Logo: If you would like to customise your PDF exports to include a logo (e. g. 

company logo) click >Browse under the Logo menu item and select the ap-

propriate logo from your data file structure. 

 › Click Open.

 – The path to your logo on your computer appears in the input field.

 › Choose the language in the dropdown menu. The following languages 

 › are available:

• German

• English 

• French

• Spanish

• Danish

• Italian

• Polish

• Russian

• Czech

 › Choose your preferred number format in the dropdown menu.

 › If desired, you can select the Anglo-American system for your calculation. 

 ›  Address: If you want to customise your PDF exports to show your address, 

enter the details in the Default address for FreqCalc projects input field. 

 › To apply these settings, click >Submit

 – The text will confirm that your details have been updated.

 ›  To return to the FreqCalc user interface, select >Dashboard and >Open  

FreqCalc via the selection window.

The Getzner Werkstoffe logo 

is included as standard in PDF 

exports. You can customise 

your PDF exports if you wish, 

by adding your company logo 

for example. If you do not want 

to include a customised logo, 

leave this box empty. 

Make sure that your logo 

complies with the following 

criteria:

File format: JPG / GIF / PNG

File size:  max. 500 kB

Aspect ratio: 7:3

NOTE
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5. User interface

 

Project area 

Input area 

(Input main bearing) 

Calculation of pre-

stressed bearing | Input 

bushing 

 

Results area 

(Bushing results) 

Results area 

(Main bearing results) 

Graphs  

Deflection curve and 

graph of isolation 

Table 

Graph of pre-stressed 

bearing 

 

 

 

Download 

buttons

Basis of 

calculation
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5.1 Project area

Project:  

Input field for the name 

of your project.

Remark:  

Input field for additional 

comments about the 

project.

Address: 

Ticking the checkbox 

loads the specified 

address. You can also 

enter an alternative 

address in the input 

field.Author:  

Shows the name under 

which you registered.

If you do not want an address 

to be included in the printed 

output, leave this field blank.

NOTE
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5.2 Input area

Material:  

Dropdown menu for se-

lecting different product 

ranges. The product 

ranges available to you 

will depend on your user 

rights.  

Quantity:  

Defines the number of 

bearings used. 

Thickness:   

Dropdown menu for 

selecting a standard 

material thickness. You 

can also enter a custom 

material thickness in 

the field.

If you ticked the checkbox for 

the pre-stressed bearing calcu-

lation function, the title chan-

ges to „Input main bearing“.

The specified thicknesses are 

standard material production 

thicknesses. Custom thicknes-

ses may give rise to additi-

onal production costs, with 

implications for delivery time 

and price.

Shape:  

Dropdown menu for se-

lecting a bearing shape. 

The following shapes are 

available:Rectangle and 

Cylinder. 

Length:  

[Condition: Shape = 

Rectangle]: Defines the 

length of your bearing. 

Width:  

[Condition: Shape = 

Rectangle]: Defines the 

width of your bearing. 

Diameter:  

[Condition: Shape = Cyl-

inder]: Defines the diam-

eter of your bearing.

Holes:  

Checkbox to activate 

the Holes function. The 

centre point of a hole is 

aligned centrically with 

the bearing. 

Quantity:  

[Condition: Holescheck-

box ticked]: Defines the 

number of holes in the 

bearing. 

Diameter:  

[Condition: Holes  

checkbox ticked]: De-

fines the diameter of 

the holes.

Load type:  

Dropdown menu for 

selecting the load type. 

The available load types 

are Load, Mass and 

Force. The input field 

determines the value of 

the specified load.

Units

Disregarding the units can 

have serious consequences for 

the calculation. Always check 

the unit when you enter the 

load value.

Secant:  

Checkbox to activate 

the Secant stiffness 

function. The input fields 

determine the lower and 

higher limits.

CAUTION

NOTE

NOTE
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Calculation button: 

Starts the calculation 

using your specified 

values.

Conditions for use 

for download

FreqCalc User Guide 

for download

Archive button:  

Opens the calculation 

archive, in which up to 

ten calculations can be 

stored.

Reset button: Restores 

the input fields and 

dropdown boxes to their 

original status.

Save button: Saves the 

current calculation un-

der the specified project 

name.

Load saved address:  

If the box is checked, 

the program automat-

ically uses the address 

specified during custo-

misation (see 4.1). If the 

box is not checked, an 

individual project ad-

dress can be entered.    
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5.3 Results area

Choose material: 

Shows the material calculated on the basis of your 

inputs. Use the orange arrows to the left and right 

of the dropdown menu to select the next softest or 

stiffest material. The results are refreshed each time 

you change the material type. 

If a material is the best one based on your inputs, 

the word „Best“ is displayed below the dropdown 

menu, against a green background.   

Shape factor:  

The shape factor is a geometric measure of the 

shape of an elastomer bearing and is defined as 

the quotient of the surface area under load and the 

curved surface area of the bearing. The deflection 

curve for elastomers is dependent on the shape fac-

tor (already taken into account in the calculation). 

Surface:  

The surface area under load of the (main) bearing.

Cellular materials such as 

Sylomer® SR 11, SR 18 and  

SR 28 are volume-compressi-

ble, so the influence of shape 

factor on stiffness can be 

disregarded. As the elastomer 

compactness increases, howev-

er, the shape factor becomes 

increasingly important.

NOTE
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Static load limit:  

Indicates the value up to which the material can be 

used under a permanent static load. This value is 

dependent on the shape factor. 

Capacity:  

The capacity of the material under the specified 

load.

Different load values 

The values for dynamic loads 

or peak loads are different from 

those for static loads. Please 

refer to the individual product 

data sheets for exact values.

Overload 

The calculated material over-

load is given as a percentage. 

The field is shown with a 

red background. Check your 

inputs and choose the next 

highest material type from the 

dropdown menu. In case of 

doubt please contact Getzner 

Werkstoffe.

Deflection:  

Distance by which the material is compressed when 

the specified load is applied.  

Natural frequency:  

Lowest vertical natural frequency of the elastically 

supported system. The lower the natural frequency, 

the higher the vibration isolation.  

Dynamic bedding modulus:  

Ratio of the dynamic stiffness to the surface area 

under load. This is also known as stiffness per unit 

area.

WARNING

CAUTION
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Dyn. modulus of elasticity:  

The result shows the dynamic modulus of elasticity 

under the specified load for the defined material 

type.  

Secant stiffness:  

This result is only displayed if the Secant checkbox 

is ticked in the Input (or Input main bearing) area 

and the lower and upper limits have been entered. 

Secant stiffness is an additional value that is not 

absolutely necessary for a load rating. Experience 

shows that this value is mainly used in the railway 

sector.

5.4 Archive

The archive can be used for storing, opening and deleting calculations.

Project: Shows the name under which the calculation was saved. 

Date: Shows when the calculation was saved. 

Open button: Inserts the stored values in the input fields in the user interface. 

Delete button: Deletes the stored calculation from the archive. 

X: Closes the Archive dialog.
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5.4.1 Saving a calculation
 

You can save calculations in the archive. To do so, proceed as follows. 

 › Enter your details in the input fields.

 › Click the Save button.

 – The calculation is saved in the archive under the specified project name.

  

5.4.2 Opening a saved calculation
 

To open a saved calculation from the archive, proceed as follows. 

 › Click the Archive button.

 – The Archive dialog opens. The saved calculations are listed as a table in date  

 order. Each record shows the project name, date and time.

 › Next to the record you wish to open, click the Open button. 

 – The input values are inserted in the input fields.

5.4.3 Deleting a saved calculation
 

To delete a saved calculation from the archive, proceed as follows. 

 › Click the Archive button.

 – The Archive dialog opens. The saved calculations are listed as a table in date  

 order. Each record shows the project name, date and time.

 › Next to the record you wish to delete, click the Delete button.

 – The record is deleted from the archive.

 › To close the Archive dialog, click X.

You can store up to ten calcu-

lations in the archive.

NOTE
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5.5 Graphs

5.5.1 Deflection curve

The deflection curve (1) maps the relation between load and deflection for the 

material type. The horizontal blue line (2) shows the static load limit for the se-

lected material type. The horizontal green line (3) shows the specified load. The 

area below is shown in green. A material overload occurs at the point at which 

the specified load exceeds the static load limit. An overload is indicated in the 

chart by a red line (5). The area below is shown in red.  

If a secant is specified, this is shown as a straight orange line (4) from the de-

fined lower limit to the defined upper limit.

(1) (5)

(2)
(4)

(3)
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Expanding areas of the deflection curve 

You can expand the view of areas of the deflection curve. To do so, proceed as 

follows. 

 › Move your mouse pointer over the chart.

 – The mouse pointer turns into a cross.

 › Position the centre point of the cross at the top left corner of the area  

 you wish to expand.

 › Hold down the left mouse button and drag the centre point of the cross  

 to the bottom right corner of the area you wish to expand.

 › Release the left mouse button.

 – An expanded view of the selected area is displayed.

Alternative: Centred zoom
 

You can expand or reduce the size of the chart view using the zoom icons on 

the right-hand edge of the chart. 

 › To zoom in, select  

 › To zoom out, select 

 › To restore the chart to its original size, select 
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5.5.2 Graph of isolation
 

The isolation curve maps the relation between isolation (in dB) and frequency 

(in Hz) of the vibrating system. The calculated natural frequency is located at 

the highest point of the curve (1). The vibrating system is at resonant frequency 

here. At the point of natural frequency x√2 the isolation curve intersects with 

the horizontal zero line (2). Up to this point an elastic mounting intensifies the 

vibration rather than improving it (area shown in red). Beyond this point of 

intersection vibration isolation is effective. The greater the difference between 

the excitation frequency and the natural frequency of the system, the more 

effective the vibration isolation (degree of isolation).

(1)

(2)
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Expanding areas of the graph of isolation 

You can expand the view of areas of the graph of isolation. To do so, proceed as 

follows. 

 › Move your mouse pointer over the chart.

 – The mouse pointer turns into a cross.

 › Position the centre point of the cross at the  top left corner of the area you  

 wish to expand.

 › Hold down the left mouse button and drag the centre point of the cross to  

 the bottom right corner of the area you wish to expand.

 › Release the left mouse button.

 – An expanded view of the selected area is displayed.

Alternative: Centred zoom
 

You can expand or reduce the size of the chart view using the zoom icons on 

the right-hand edge of the chart. 

 › To zoom in, select  

 › To zoom out, select 

 › To restore the chart to its original size, select 
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5.6 Table
 

The table under the graph of isolation shows the frequency spectrum, isola-

tion and degree of isolation for the calculation. A negative degree of isolation 

denotes a worsening of the situation, a positive degree of isolation an improve-

ment. 

Example:  

At an excitation frequency of 40 Hz the system isolation is     

 -15.8 dB. This corresponds to a degree of isolation of +84%.

In vibration isolation the de-

gree of isolation characterises 

the isolation effect as the ratio 

between the input and output 

forces or the input and output 

amplitudes. 

NOTE
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Download buttons:

Language selection: 

Dropdown menu for choosing the language in which the calculations are to be 

downloaded. This allows you to create a PDF of the calculation in a different 

language from the input language. 

Calculation button: 

Creates a PDF file of the entire calculation and starts the download process. The 

file includes the Project, Input and Results areas and the basis of calculation. 

Product datasheet button: 

Starts downloading the calculated product datasheet.

In the case of a pre-stressed 

bearing calculation the data-

sheet relates to the main 

bearing.

Basis of calculation:

The basis of calculation describes the exact assumptions on which the FreqCalc 

calculation is based (see also Appropriate usage). It also includes the date on 

which the material data was last updated and the software version number.

Material data 

The date on which the material 

data was last updated may 

vary depending on the materi-

al type. Users are not notified 

if the material data is changed. 

Check the date of the material 

data at regular intervals, espe-

cially if you have saved calcu-

lations in the archive. Changes 

to the material data may cause 

the calculation results to vary.

NOTE

CAUTION
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5.7 Additional option for pre-stressed bearing calculation 

Calculation of pre-stressed bearing | Input bushing:  

Checkbox to activate the pre-stressed bearing calculation 

function and the input fields for bushings.

Bolt 

Preload element 

Bushing 

Machine base 

Main bearing 

Foundation

Schematic diagram of a pre-stressed bearing:

5.7.1 Input bushing area
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Material:  

Dropdown menu for se-

lecting a material type. 

The material types avail-

able to you will depend 

on your user rights. 

Bushings per main 

bearing:  

Defines the number 

of bushings per main 

bearing. 

Thickness:  

Dropdown menu for 

selecting a standard 

material thickness. You 

can also enter a custom 

material thickness in the 

field. 

Shape:  

Dropdown menu for se-

lecting a bearing shape. 

The following shapes are 

available:Rectangle and 

Cylinder. 

Length:  

[Condition: Shape = 

Rectangle]: Defines the 

length of your bearing 

Width:  

[Condition: Shape = 

Rectangle]: Defines the 

width of your bearing 

Diameter:  

[Condition: Shape = 

Cylinder]: Defines the 

diameter of your bearing

Holes per bushing:  

Checkbox to activate the 

Holes function. 

Quantity:  

[Condition: Holes per 

bushing checkbox 

ticked]: Defines the 

number of holes in the 

bushing. 

Diameter:  

[Condition: Holes per 

bushing checkbox 

ticked]: Defines the di-

ameter of the holes. 

Deflection under 

preload:  

Defines the desired de-

flection under preload.

Owing to the differing loads, 

the material type used for the 

bushing is not dependent on 

the material type used for the 

main bearing. The choice of 

material type is governed by 

the required preload force.

The specified thicknesses are 

standard material produc-

tion thicknesses. Custom 

thicknesses may give rise to 

additional production costs, 

with implications for delivery 

time and price.

NOTE

NOTE
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5.7.2 Bushing results area

Shape factor:  

The shape factor is a geometric measure of the 

shape of an elastomer bearing and is defined as 

the quotient of the surface area under load and the 

curved surface area of the bearing. 

Surface (*):  

The surface area under load of the pre-stressed 

bearing.

Load of bushing: 

Calculated from the preload force and the 

surface area.

Capacity:

The material capacity with the calculated 

preload force.

Preload force (*):  

The force acting on the bushing. 

Dyn. Stiffness (*):  

Determined from the selected material and the 

calculated preload.  

(*) refers to all bushings per main bearing.

The necessary preload force 

is determined by the specific 

installation situation. In case of 

doubt please contact Getzner 

Werkstoffe.

Overload 

The calculated material over-

load is given as a percentage. 

The field is shown with a 

red background. Check your 

inputs and choose the next 

highest material type from the 

dropdown menu. In case of 

doubt please contact Getzner 

Werkstoffe.

NOTE

WARNING
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Additional results in the main bearing area 

Additional  load on main bearing:  

Additional load acting on the main bearing if a bus-

hing is used. 

Total load:  

Sum of the additional load on the main bearing and 

the load.
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5.7.3 Graph of pre-stressed bearing 

This graph only appears if the Calculation of pre-stressed bearing checkbox is 

activated. 

The graph shows the deflection curve for the main bearing (1) and bushing 

(2). The purple line (3) indicates the load on the main bearing as a force. The 

turquoise line (4) represents the preload force arising from the deflection under 

preload.

(3)

(1)

(4)
(2)
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Expanding areas of the pre-stressed bearing graph 

You can expand the view of areas of the pre-stressed bearing graph. To do so, 

proceed as follows. 

 › Move your mouse pointer over the chart.

 – The mouse pointer turns into a cross.

 › Position the centre point of the cross at the top left corner of the area you  

 wish to expand.

 › Hold down the left mouse button and drag the centre point of the cross to  

 the bottom right corner of the area you wish to expand.

 › Release the left mouse button.

 – An expanded view of the selected area is displayed.

Alternative: Centred zoom
 

You can expand or reduce the size of the chart view using the zoom icons on 

the right-hand edge of the chart. 

 › To zoom in, select  

 › To zoom out, select 

 › To restore the chart to its original size, select 
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6. Case studies 
 
6.1 Case study 1: Simple bearing calculation 

Scenario: 

A machine with a dead weight of 9 tonnes is to be elastically supported. The 

machine stands on four feet, each with a bearing surface of 250 x 250 mm. The 

disruptive vibrations start at an excitation frequency of 50 Hz. Isolation of at 

least -15 dB is required. 

Step 1: Enter data

 › In the Quantity field in the Input area enter 4.

 › In the Length and Breadth fields enter 250.

 › In the Load type dropdown menu select Mass and in the input field enter  

 9000.

 › Click the Calculation button.

Step 2: Results

 – Sylomer® SR 450 was calculated to be the best material.

 – The material capacity is 81%.

 – The natural frequency was calculated at 11,8 Hz.

 – The graph of isolation shows the degree of isolation at an excitation               

 frequency of 50 Hz.

 – The table indicates an isolation of -24,2 dB at an excitation frequency of  

 50 Hz. The degree of isolation is 94%.  

 This satisfies the minimum required value.
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6.2 Case study 2: Pre-stressed bearing calculation 

Scenario: 

A machine with a dead weight of 9 tonnes is to be elastically supported. The 

machine stands on four feet, each with a bearing surface of 250 x 250 mm. 

The disruptive vibrations start at an excitation frequency of 50 Hz. An isolation 

value of at least -15 dB is required.  

Owing to a lifting force of 3 kN, the machine must be anchored to the founda-

tion. This is to be achieved by means of one preload element  

per machine foot (120 x 70 mm) and two bolts (M20).

Step 1 – Step 2: Use values from case study 1 

Step 3: Enter bushing data

 › Tick the Calculation of pre-stressed bearing | Input bushing

 › In the Thickness dropdown menu select 12,5.

 › In the Length field enter 120 and in the Width field enter 70.

 › Tick the Holes per bushing

 › In the Quantity field enter 2.

 › In the Diameter field enter 22.

 › In the Deflection under preload field enter 1.

Step 4: Adjust the main bearing input

 › In the Input main bearing area tick the Holes per pre-stressed element

 › In the Quantity field enter 2.

 › In the Diameter field enter 22.

 › Click the Calculation button.

Lifting force 

This causes the structure 

to „lift“ in the support area 

unless it is anchored down or a 

corresponding load is applied 

in the support area.

Holes 

An M20 bolt has a diameter of 

20 mm. To make it easier to 

pass the bolt through the hole 

on assembly, it is advisable for 

the hole to be larger than the 

bolt. In this case an empirical 

value of +2 mm is chosen.

NOTE
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Step 5: Main bearing results 

 – The natural frequency has changed and is now 11,7 Hz.

 – The capacity is 91%.

Step 6: Bushing results

 – The bushing capacity is 72 %.

 – The preload force was calculated at 2,15 kN. Given the lifting force of 3 kN,  

 the preload force is too low.

Step 7: Adjust the bushing input

 › In the Material area select the next stiffest material, in this case    

 Sylomer® SR 850.

 › Alternative 1: Enter a different value in the Deflection under preload field.

 › Alternative 2: Adjust the bushing dimensions.

 › Click the Calculation button.
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Step 8: Results

 – The main bearing capacity is 98%.

 – The natural frequency was calculated at 12.0 Hz.

 – The bushing capacity is 77%.

 – The preload force was calculated at 3.85 kN. This is high enough to counteract 

 the lifting force.

 – The graph of isolation shows the isolation effect at a disruptive frequency of  

 50 Hz.

 – The table indicates an isolation of -24.0 dB at an excitation frequency of  

 50 Hz. The degree of isolation is 94%.   

 – This satisfies the minimum required value.

 – The pre-stressed bearing graph shows the deflection curves for the main  

 bearing and bushing. The purple line represents the dead weight of the  

 machine as a force. The turquoise line represents the preload force.
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7. Frequently asked questions

Is there an offline version of FreqCalc? 

No. FreqCalc is only available online via the Getzner Werkstoffe homepage. 

Do I have to register in order to use FreqCalc? 

Yes. You need to set up a user account on the Getzner Werkstoffe homepage in 

order to use FreqCalc. 

I have registered for FreqCalc but I still can‘t use FreqCalc. Why not? 

The registration process may not be complete yet. 

Is FreqCalc available in other languages too? 

Yes. FreqCalc is available in German, English, French, Spanish and Danish. Other 

language versions are being developed. 

Do I need to change the program language in order to print out a PDF file in 

another language?  

No. In the footer of the Results area you can choose the download language. 

Will I be notified of changes to the material data? 

No. You will not be notified. The current date of the material data appears in 

the basis of calculation in the footer of the calculation program and of the PDF 

exports. 

I have added a logo to customise my user profile. Why does the logo look 

distorted? 

Check that the aspect ratio is correct. Your logo must have an aspect ratio of 

7:3. 

How many calculations can I store in the archive? 

You can store up to ten calculations in the archive. To store new calculations, 

delete those that you no longer need. 

I‘ve forgotten my password! How can I request a new one?

Please refer to Resetting a password. 

FreqCalc does not display correctly!

Check which version of your web browser you are using and update it if nec-

essary. If you still experience problems, please contact online support. Email: 

onlinesupport.buers@getzner.com
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8. Glossary

Natural frequency 

Frequency at which an oscillating system oscillates 

freely after a single excitation; the attenuation time 

is dependent on the isolation. 

Vibration isolation 

Reduction in the transfer of mechanical vibrations 

by the installation of elastic intermediate compo-

nents; a distinction should be made between reduc-

ing the transfer of vibrations from a vibration excit-

er to the environment (emission control, isolation 

of the exciter) and shielding an object against the 

effects of vibration from the environment (environ-

mental control, shielding of an object). 

Polyurethane 

Abbreviation PUR or PU; polyurethanes are pre-

pared by the polyaddition of isocyanates and 

polyalcohols and can range from cellular through to 

compact structures. A distinction should be made 

between polyether urethanes and polyester ure-

thanes. 

Single degree-of-freedom (SDOF) oscillator 

Vibration isolation applications are often idealised 

on the basis of an oscillating system with a single 

degree of freedom, consisting of a mass and a 

spring. 

Deflection curve 

Describes the relation between load and deflection 

in graphical form; depending on the rate of loading 

it may be a quasi-static or a dynamic deflection 

curve. 

 

 

 

Degree of isolation 

In vibration isolation characterises  

the isolation effect as the ratio 

between the input and 

output forces or the input and 

output amplitudes. 

Pre-stressed bearing 

A pre-stressed bearing is a bearing designed to 

prevent transmission of structure-borne noise in 

mountings. Each pre-stressed bearing consists of a 

main bearing and a bushing. 

 

Additional terms can be found in the Getzner  

Werkstoffe glossary at http://www.getzner.com 

Downloads>Brochures>Glossary 
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